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Welcome to Internet Assistant for Microsoft Word
Version 2.02z

US, Italian, French, German, Dutch, Swedish, Norwegian, Finnish, Danish,
Spanish, Brazilian, Portugese, Czech, Polish, Russian, Greek, Turkish,

Hungarian, Slovenian

This document contains the following information:
(Double-click the blue underlined text to view the topic, or simply scroll down if Internet Assistant is not 
currently installed.)
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6. HREF="#Known
7. HREF="#tcpip
8. HREF="#help

1. New Features added since Internet Assistant version 1.0
· Much faster HTML import
· On conversion of Word documents, embedded graphics will be exported to .GIF 

files and links to them will be created in the HTML file.
· Authoring support for common HTML extensions including 

· centering
· background images
· background color
· text color
· hyperlink color

· View HTML Source - a feature that allows you to view and edit the HTML tags (e.g.
<p>) in your document.

· AutoFormating in HTML Source - a feature that allows you to make the HTML 
more readable.

· HTML Table support - You can now convert your Word tables into HTML or create 
and edit them directly in an HTML document.

· All Internet Explorer HTML extensions including:
· Font color
· Font face
· Background sound 
· Marquee
· Watermark
· Inline video

· ‘Preview in Browser’ - This feature allows you to invoke your favorite browser to 
preview the file that you are editing.   

· Font size control



· Superscript and Subscript tag authoring
· Extended HTML form support including new HTML form dialogs
· A completely overhauled Windows 95 user interface
· Improved Setup

2. Installing Internet Assistant
This release of Internet Assistant only works with US, Italian, French, German, Dutch,
Swedish, Norwegian, Finnish, Danish, Spanish, Brazilian, Portugese, Czech, Polish, 
Hungarian, Turkish, Slovenian, and Russian versions of Microsoftâ Word for 
Windows 95 7.0 and higherâ and Microsoftâ Word 6.0 for Windows NTâ. You can 
verify which version of Word you have by selecting About Microsoft Word from the 
Help menu.

Recommended System Requirements:
· Personal computer using a 386 or higher processor
· Word 7.0 for Windows 95 or Word 6.0 for Windows NT
· 8M RAM or more
· Hard disk with 2M of available disk space ot run (6 meg required during setup)
· VGA or other high-resolution display supported by Microsoft
· Windows 95 or Windows NT
· Mouse or other Windows pointing device

To install Internet Assistant from the Internet:
Instructions for downloading Internet Assistant 2.0 are available from
HREF="http://www.microsoft.com/msoffice/freestuf/msword/download/ia 
· Select the download and execute options from the page identified above.
· Exit from Word.
· Follow the instructions on your screen.
· After setup completes successfully, launch Word.
· Select the Browse Web command from Word’s File menu.

To install Internet Assistant from the WRDIA20Z.EXE file:
Place the file WRDIA20Z.EXE in a local temporary directory on your hard drive and 
double click on the file in the Windows Explorer or Program Manager. The Internet 
Assistant will decompress and install in one action.
  
Setup Steps:
· (Previous WordIA users) Setup will make a backup copy of favorite.doc in 

your Internet Assistant folder (e.g. c:\Program Files\Internet Assistant\
favorite.doc)

· Exit from Word.
· Double click on wordia2b.exe from the folder where it is located on your hard 

disk.
· Follow the instructions on your screen.
· After setup completes successfully, launch Word.
· Select the Browse Web command from Word’s File menu.
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3. Troubleshooting Setup Problems
· Incomplete Setup - Incompatible version of Word detected.

Setup has detected an incompatible version of Word.

NOTE: This version of Internet Assistant supports US, Italian, French, 
German, Dutch, Swedish, Norwegian, Finnish, Danish, Spanish, Brazilian, 
Portugese, Czech, Polish, Russian, Hungarian, Turkish, Slovenian, and Greek 
versions of Microsoftâ Word for Windows 95 7.0 and higherâ and 
Microsoftâ Word 6.0 for Windows NTâ.
· It does not support Word 6.0, 6.0a, or 6.0c (16 bit versions).
· It does not support any other international versions of Word for 

Windows.

If you have multiple versions of Word — one of which US, Italian, French, 
German, Dutch, Swedish, Norwegian, Finnish, Danish, Spanish, Brazilian, 
Portugese, Czech, Polish, Russian, Hungarian, Turkish, Slovenian, or Greek 
version of Microsoftâ Word for Windows 95 7.0 and higherâ and Microsoftâ Word
6.0 for Windows NTâ. — and Setup still reports that an incompatible version of 
Word was detected, ensure that a supported version of Word is that last one that
you launched prior to installing Internet Assistant..

· Problems running WRDIA20Z.EXE.
If you downloaded Internet Assistant from Microsoft’s Web or FTP server it is 
possible that the download was not successfully completed. If the extraction 
hangs it is likely that WRDIA20Z.EXE was damaged during the downloading 
process. Try downloading WRDIA20Z.EXE again. The downloaded file should 
be approximately 1.1 MB.

· Setup reporting that there’s not enough memory to run.
To successfully set up Internet Assistant it is recommended that there be at 
least 4 MB of free hard drive space.  Free up some space and run Setup 
again.  (Is this still true)

· Setup Reports that  it cannot open a file.  
This may happen if previous versions of Internet Assistant are not removed 
before installing version 2.0Z.  Remove the all versions of Internet Assistant and
reinstall.
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4. Removing Internet Assistant
It is recommended that you remove any previous versions of Internet Assistant 
before installing this release. On Windows 95, this can be done through the 
Add/Remove Programs icon in the Control Panel.  On Windows NT, run IASETUP.EXE  
from the \{Internet Assistant}\Setup directory.  On previous versions of Windows, 
this can be done by rerunning Setup and selecting “Remove All.”

NOTE: You may wish to back up FAVORITE.DOC located in your \
{Internet Assistant} directory by saving it with another name prior 
to rerunning IASETUP. 
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5. Outputing characters above ASCII 128
Characters above ASCII 128 can be represented in several ways. Characters are 
either represented as octet ('native') characters, or as character entities (&Auml). 
Depending on what your local HTML standard is, you can choose the setting that 
matches the standard. 
Choose how to represent characters above ASCII 128 in your HTML documents by 
doing the following:
1. Make sure you have your HTML document open. The document need to be based

on the template HTML.dot.
2. Select Macros on the Tools menu.
3. Select the HTMLSetOutput macro, and click Run.
4. Select the setting you want to click OK.
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6. Known Issues

If you have Internet connectivity you can obtain current information on known 
issues at HREF="http://www.microsoft.com/pages/deskapps/word/ia/support.htm.

· HTM documents look different after saving, closing and re-opening.
Because Internet Assistant writes valid HTML (specification 2) with Netscape and 
Internet Explorer extensions, you may notice a difference in the appearance of 
your file when you save, close and re-open it.  If you have been authoring a file 
in another application and are unsure of how its compatibility with the HTML 
supported by Internet Assistant, you might want to make a backup copy before 
trying it.

· Using characters with accents.
It is recommended that you avoid using characters with accents in filenames 
and URL references. Browsers on different operating systems (e.g. Windows, 
Macintosh, or UNIX) represent these characters differently and there may be 
unexpected results when the document is loaded.  It is, however, safe to use 
characters with accents in the text of HTML documents. 

For the same reasons, you should avoid saving HTML documtents to folders 
with extended characters.

· Downloading files from the Web.
When you exercise a link while browsing the Web, you are copying content to 
your local drive.  In some cases, the content that comes down may be an 
executable file which will be executed when it is downloaded.  There is a 
potential for such a file to contain a virus.  Be aware of what you are 
downloading.  If you have any concern about a file, use Internet Explorer to 
download the file without executing it and use your virus checking software to 
check the file for any problems.

· Extensive manipulations of tables can result in layout changes
Internet Assistant writes HTML tags into table cells. These tags are represented 
by asterisks.  Any changes to the content or position of these tags (asterisks) 
will have an effect on the layout of the table.  There are several strategies for 
reducing the potential for this problem.

· Avoid repeated splitting and merging operations on the cells
· If you plan to do extensive layout changes:



· Make your changes to the table layout before entering content into 
the table

· Create the table in a separate Word document,. save the document
as HTML, and Paste it into your HTML document.

· Disappearing Hyperlinks
There are cases where editing an existing hyperlink may cause the hyperlink to 
disappear.  This appears to be a problem only if the hyperlink is associated with 
an image and you have recently saved the document.  If you need to change an 
existing hyperlink be sure you have the information needed to recreate the link.

· Bulleted List formatting
There is a known problem with Bulleted Lists. When having formatted a 
paragraph as a bulleted list, you can not undo the formatting by clicking on 
Bullets in the Formatting toolbar. To undo the formatting, click on Undo button 
in the Standard toolbar, or choose Undo Style on the Edit menu. 

· Incorrect Context Menus
There are cases where a document based on the template Normal.dot will 
display context menus for documents based on HTML-related templates. To 
restore the correct context menues, activate your Word document and click the 
"Browse View" button and then go back by clicking the "Edit View" button.

· Creating Greek HTM documents with US version of Word
If you are using the US version of Microsoft Word and try to create Greek htm 
documents, you will see ANSI fonts instead of Greek fonts. To display the Greek 
fonts, you need to manually substitute the default ANSI font with a Greek one.
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7. TCPIP/WSOCK32.DLL Compatibility
Internet Assistant’s browsing, link validation and Copy Hyperlink features require an 
Internet connection.  To use these features, you must have the following installed or 
connected to your computer:

· A 32-bit Winsock (wsock32.dll) compliant TCP/IP product (talk to your TCP/IP 
vendor)

· Physical or dial-up connection to the Internet

IMPORTANT: If you are using a 16-bit winsock.dll you will not be able to connect to 
the Internet with Internet Assistant.  Contact your Internet service provider for 
instructions on upgrading to wsock32.dll.
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8. Getting Help

Internet Assistant includes fully detailed online help, which is available from the 
Help menu when the active document is based on HTML.DOT. The DEFAULT.DOC 
document is opened when you choose the Browse Web command from the File 
menu. It contains hyperlinks to three documents: CREATING.DOC, NAVIGAT.DOC, 
and TIPS.DOC. These documents give a brief introduction to Internet Assistant and 
illustrate many of its powerful features. 



If none of these sources solve your problem, registered Word users may contact 
Microsoft Product Support Services for help. For information on contacting Product 
Support Services, choose Technical Support from the Help menu.
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Thank you for using Internet Assistant for Microsoft Word.
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